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Copyright

Copyright © 2006 University of lllinois. All rights reserved. No part of this publication may be
reproduced or used in any form or by any means — graphic, electronic or mechanical, including
photocopying, recording, taping or in information storage and retrieval systems — without written
permission of OBFS Training, Performance Development & Communications, University of lllinois.

Trademarks

Banner 7.2 ® is a registered trademark of SunGard SCT Corporation.

APPROPRIATE USE AND SECURITY OF CONFIDENTIAL AND SENSITIVE INFORMATION

Due to the integrated nature of the various Human Resources, Finance, and Student modules in Banner and the
reporting information in the Enterprise Data Warehouse (EDW), you may have access to information beyond what
you need to perform your assigned duties. Your access to Banner and the EDW has been granted based on
business need, and it is your responsibility to ensure the information you access is used appropriately.

Here are some reminders of good data stewardship to help you carry out your responsibility:

Do not share your passwords or store them in an unsecured manner. Do not leave your workstation
unattended while logged on to administrative information systems. You are responsible for any activity
that occurs using your logon ID.

Do not share confidential and sensitive information with anyone, including colleagues, unless there is a
business reason.

Retrieve printed reports quickly, and do not leave the reports lying around in plain view.

Secure reports containing confidential and sensitive information (e.g., FERPA, EEO, or HIPAA protected
data).

Regarding FERPA, the University of Illinois maintains individual records and information about students
for the purpose of providing educational, vocational, and personal services to its students. Itis
University policy to comply fully with federal statutes and regulations regarding the confidentiality of
student educational records. As required by the Family Educational Rights and Privacy Act (FERPA) of
1974, as amended, University policy outlines procedures covering the privacy rights of students. The
policy is intended to ensure the confidentiality of student education records, to establish the right of
students to inspect and review their education records, and to provide guidelines for the correction of
inaccurate or misleading data.

When disposing of reports containing confidential or sensitive information, shred the documents in a
timely manner.

Your responsibilities regarding the protection and security of administrative information are outlined in the
University of lllinois Information Security Policy for Administrative Information and Guidelines posted at
http://www.obfs.uillinois.edu/manual/central_p/sec19-5.htm. Any violation could subject you to disciplinary action,

which could include dismissal or, in those cases where laws have been broken, legal action. You should have
signed a compliance form that indicates you have read, understand, and agree to comply with the University's
Information Security Policy for Administrative Information. If you have not already signed the compliance form,
please see your Unit Security Contact, who is responsible for maintaining these forms.



http://www.obfs.uillinois.edu/manual/central_p/sec19-5.htm
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Adding Your URLs t

0 My Links

In Banner 7.2, you can customize the URLs under the My Links section that appears on the main
menu. These links open the defined URL in a new web browser when clicked once. The link to My

Institution defaults to www.uillino

is.edu, while the links to each campus link to each campus

homepage. You can customize up to 6 links (including the default links to each campus homepage)
using the General User Preferences Maintenance Form (GUAUPRF).

Steps to Customize My Links

To add your own personalized URLs to the Banner 7.2 main menu’s My Links section:

1. From the File menu, select
Preferences, or type
GUAUPREF in the
Go To... field and press
ENTER.

The General User
Preferences Maintenance
Form will open.

2. Click the My Links tab.

Add your URLs and
descriptions in the User
Value fields.

The first section of three lines is
set to the My Institution link and

you should not change that —

setting.

In any of the other sections of six
lines, you can set values for your
links.

a) Inthe first User Value field,
type what you want your

URL to be named. In this A

example, it is the OBFS
home page.

b) Inthe next User Value field,
you will type the URL for
your link. This example
uses:
http://www.obfs.uillinois.edu

In the next sections, repeat steps

a. and b. if you want to add more
links.

Edit Options  Block  [td

Direct Access = [q
Ohject Search

QuickFlow

Select

Rollback

Save

Refresh STUDENT]
Er|_nt ystem Me
Exit

Exit QuickFlow sources [
Exit SCT Banner GENERAL]

Return to Meiu

Display Options  Directory Options My Links Menu Settings LA

Description: |Enter the URL for the "My Institution" link.

Default Value: |http:f£www.ui|linois.edu

User Yalue: |hittp: /4w uillinois.edu

Description: |Enter the description for the "My Personal Link 4" link,

Default Yalue: |Y0urfourth personal link description

OBFS Home Page| Type the descripfion of the Tink here
(thisis how it will appear on your screen)

User Value:

|Enter the URL or Banner object for the "My Personal Link 4" link,

|http:,-",-"www.google.com

User Value: )ttp:,-",-"www.obfs.uillinois.edu Type the URL of the link here.

Desceifition: |Enter the description for the "My Personal Link 5" link.

A Default Value: |Y0urﬁfth personal link description

|DART Applications  Type the description of the link here
(this is how it will appear on your screen)

User Value:

|Enter the URL or Banner object for the "My Personal Link 5" link,

Default Value:  [vour fifth personal link URL

W |https:.-".-"’hrnet.uihr.uillinois.edu.-"dar‘t—cf.-"admin.-'"index.c:Frn Type the URL of
the link here.
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4. Click the Save button or press
F10 when you have added all
of your links.

5. Click OK when you receive a
message like the one to the
right.

6. Click the Exit button on the

GUAUPRF window to return to

the Banner main menu.
7. Exit Banner completely.

8. Log into Banner again to see
your personal links as you
have programmed them. In
the screen shot to the right,
the links described in previous
examples appear.

9. Click the desired link and your
web page will open in a new
browser window.

SCT Banner

Your "Hyperlink description” changes will anly be seen
after you exit and log back into SCT Banner.

My Links
UIc
UIs

UIUC

OBFS Horme Page
DART Applications

Personal Link &

Check Banner Message

Note: If a new browser window does not open, it may
be because your Internet Pop-up Blocker settings are
not allowing the new browser window to open. You
can test this by holding down the CTRL key on your
keyboard while clicking the link. If this works, you can
either:

A) Change your Pop-up Blocker settings by accessing
the Tools menu, Pop-up Blocker, Pop-up
Blocker Settings... and adjusting your settings.

OR

o
‘@

Help

Mail and Mews L

Pop-up Blocker
Manage Add-ons...
Synchronize...

B) Keep your Pop-up Blocker settings as they are and
hold the CTRL key each time you open your links
from Banner.
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Customizing Color Settings

Using the General User Preferences Maintenance Form (GUAUPREF), you can change your color
settings for Banner. You can customize the color for the following areas:

e Non-iconic buttons — any button not on the toolbar

e Canvas — the background color of forms

e Code / description prompts — field names with a list of values associated with it

e Menu links canvas — color of the My Links section of the main menu

e Record highlighting — color of the record currently highlighted in a form

e Scroll bar — color of the scroll bar on the main menu or any form

e Separator line — color of the line separating sections in a form or on the main menu
e Menu tree canvas — color of the menu tree area of the main menu

Below are pictures indicating each of these areas.

[
"mGeneral Menu GUAGMHNI MOME) - Friday M

Go To... EI Welcome, ARANSOM Products: B

Menu | Site Map | Help Center

DMV Banner
LSCT Banner
OBFS

_Istudent [*STUDENT] I
Lladvancement [*ALUMNI]

My Links

DERT

_IFinancial [*FINANCE] e T
_IHuman Resources [*HRS]

C1@eneral [*GENERAL] Wiew Dirgct

Menu Tree Canvas
Eddie Reparts

ANA

Check Banner Message

Menu Links
Canvas

My Institution

Separator Line

L ITY OF ILLINOIS

-

Scroll Bar ]

-

Banner Broadcast Messages

Areas on main menu on which colors can be customized
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-t

D: [s55352986 [~ [Hamer Simpson

Canvas

L eave Balance Totals Separator Line

Leave Day Total Begin Total Total Current Total
Code or Hour Balance Accrued Taken Available Banked

FLHL  FloatHol

SHEN  ShBen

BEE Compsic

SICK  Sick

vach Wacation

vacc vasal Record
Highlighting

[IRRNIE M
[IRNIRE M
[TTTLLLLL
[NRRRIREE M

I3

=]
=)
=)

o
oo
=

=)

L

Scroll_
Bar

TTTIT
11

Areas on forms on which colors can be customized

ID: [655352986 [ |
Position: |Ue5a72 - Suffix: oo [+ G *WARNING* This Person has a current status of
[_ [_ g terminated. To change the status to Active, go to the

Employee Form. .
Non-lconic Button

General Job EHMI Payroll Default Deferred Pay Miscellaneous  Excluded

Effective Date: 16-MAR-2005

Personnel Date: EEEEIE (= Non-iconic button: color can be customized
Status: |Active -

Title: |\.-'st Staff Devlp (Trng) Mgr

Job FTE: [ 1000

Appointment Percent: M Code Ilf

Encumbrance Hours: l— Description

Encumbrance Indicator: Systern Calculated
Hours per Day: g

Prompts

Employee Class: Bn'ﬂlnc_:adfpro 12mth Ben Elig
Leave Category: EEI 12/12 mth 2 FH 25
Change Reason: |OT006 EHData Carrection
Employer Code: ,LII—E|University of Illinois

More areas on forms on which colors can be customized
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Steps to Customize Banner 7.2 Color Settings

NOTE: You cannot make changes in GUAUPRF while forms are open.

From the File menu, select
Preferences, or type GUAUPRF in
Go To... field and press ENTER.
The Display Options tab of
GUAUPRF will open.

Observe the User Interface Color
Settings section. From here, you
can see default settings for various
color categories, e.g., the canvas,
buttons.

Click the Search icon in the User

Value field EI to change a color for
a category.

Click your selected color for the
category. This will become the value
shown in the User Value field.

Click OK.

Note: After you make a selection,
you will see the selected color in the
background of the User Value field.

Repeat steps 3-5 as needed.

Click the Save button or press F10
after you have changed the colors.

Click the Exit button on the
GUAUPRF window to return to the
Banner main menu.

QuickFlow

Refresh
Print
Exit

Ohbject Search E

[Preferences

STUDENT]
ystem Me
sources [
GEMNERAL]

User Interface Color Settings

_R§

Description:

User Yalue:

Description:

User Yalue:

Description:

User Yalue:

Description:

User Yalue:

Description:

User Yalue:

Default Yalue:

Default Yalue:

Default Yalue:

Default ¥alue:

Default ¥alue:

|Enterthe RGB color code for non iconic buttons,

|r204g204b153

[rz049153b255
|Enterthe RGB color code for the canvas.

[r2559255b255

[r204g204b255 (]

|Enterthe RGB color code for code/description prompts.

| )

|Enterthe RiGE color code for the menu links canvas.

[r2550255b255

| (]

|Enter the RGB color code for the menu broadcast message canvas.

[r2559255b255

| (]

| v
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Steps to Restore Colors to Default

If you find you want to return any of the customized colors to the default colors, follow the steps
below.

NOTE: You can not make changes in GUAUPRF while forms are open.

From the File menu, select
Preferences, or type
GUAUPRF in Go To... field
and press ENTER. The
Display Options tab of
GUAUPREF will open.

QuickFlow

Refresh
Print
Exit

]
Ohbject Search E

Prerences ™ |

STUDENT]
ystem Me
sources [
GEMERAL]

Locate the color category you
wish to change. Click in the
User Value field.

Select Remove from the
Record menu. You will
receive a warning as pictured
on the right.

Click Yes.
Repeat steps 2-4 as needed.

Click the Save button or
press F10 after you have
changed the colors.

Click the Exit button on the
GUAUPRF window to return
to the Banner main menu.

A

*NOTE* Deleting this record will reset the value to the
default. Continue?
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Checking the Banner Message Link

If you are anticipating the approval of a Banner transaction that first must be reviewed by an Office of
Business and Financial Services (OBFS) unit, you will need to periodically observe the Check
Banner Message link under the My Links section of the Banner main menu. The presence of a
green check mark (\/) to the right of the Check Banner Message link means that there is a message

from an OBFS unit for the user. Clicking the link will open the General Message Form (GUAMESG)
and reveal the message related to the Banner transaction.

If you are working in a Banner form, you may check for Banner messages by clicking the View/Send

Message button located on the toolbar. There is no difference in the appearance of the button when
a message is present.

& Oracle Developer Forms Runtime - Web

File Edit ©ptions Block Item Record Query Tools HNp

B I EE Gm@ @ X

[ ERE R [

Go To... | [*] welcome, MNEVILL

Products: B Menu | Site Map | Help Center

1My Banner My Links
—SCT Banner
(1 student [*STUDENT] e
LlAdvancement [*ALUMMNI] uis
_IFinancial [*FINANCE]

UiJC
L 1Human Resources [*HRS]

_IFinancial Aid [**RESOURCGCE]
_1General [*GENERAL]

Check Banner Message hd

_1XtenderSolutions [*BXS]

Example of
message waiting
indicator
My Institution
Banner Broadcast Messages
Enter the ohiect name; Press CQUERY for messages, LIST for listing. |
Record: 114 | L | | «ogC=
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